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Welcome 

Thank you for using CypOne laser cutting control Software! 

CypOne software is designed for fiber laser sheet cutting machine. It integrates 

functions  of  laser  technique,  parts  nesting  and  CNC  control  etc.  Main  function 

features consist of drawing processing, parameter setup, process customizing, parts 

nesting, tool path planning and simulating, and cutting process controlling etc. 

CypOne has to work with control card to realize machining control. 

It will run as Demo mode in the computer without control card, while users still 

can operate most of the functions except machine control. You can modify drawing, 

edit toolpath and other designs on your laptop in the office, send file to machine for 

cutting. 

This manual only contains operation descriptions for CypOne main program, for 

CypOne config tool and other programs work with CypOne please refer to related 

manual or contact our support. 

The  document  is  based  on  CypOne 6.1.723,  there  will  be  difference  in  later 

version-ups. 

If you have any question or advice in usage of our products, welcome to contact 

us by email support@fscut.com.
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The  working  and  cutting  performance  of  the  machine  are 
directly related to the material, laser, cutting gas, gas pressure 
and  the  parameters  setup.  Please  be  cautious  in  parameter 
setting! 

Improper  parameter  setting  and  operation  may  reduce  the 
cutting  performance,  or  even  cause  damage  and  injury  to 
machine parts and human body. CypOne software has already 
designed  multiple  protections,  meanwhile  manufactures  and 
users  must  follow the  safety  operation  rules  in  case  of  any 
accidents and injuries. 

Shanghai  Friendess  Electronic  Technology  Corporation  Limited 
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1. Quick Start 

1.1 Function Features 

Support AI, DXF, PLT, Gerber, LXD file format, and standard G code created 

by Master Cam, Type3, ARTCUT etc. 

Optimize  imported  drawing  automatically  -  delete  duplicates,  join  lines, 

delete invisible and unnecessary figures of specified size, identify inner and outer 

contour  and  sort  automatically  etc.,  which  all  can  be  parametrically  defined  or 

manually done. 

LED matrix function is designed for advertising decoration with LED lights 

that filling circles to part geometry in user defined pattern. 

Divide  function  is  to  split  large  shape  into  small  pieces  fit  for  smaller 

machine bed. Split parts will be grouped and marked which let it recognizable for 

later picking up and putting together after cutting. 

You can also measure curve length to estimate the material needed in later  

process. 

Support  common  operations  to  zoom,  translate,  flip,  rotate,  align  and 

duplicate object. 

Support  to  add  technique  features  including  lead  lines,  kerf  width 

compensation, micro joint tags, bridge and gap in a what-you-see-is-what-you-get 

style. 

Automatically identify inner and outer contour, compensation direction and 

check the lead line. 

Support to break and join line segments, smooth lines, combine and explode 

geometry etc. 
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Quick nest parts geometries into plate via a few clicks. 

Flexible sorting functions. User can group the geometries to lock the cutting 

sequence. 

Preview the cutting sequence statically or dynamically. 

Quick set Fly Cut tool path. 

Support flexible methods to execute piercing process, which allow users to 

group  piercing  sequence,  select  piercing  stages  and  customize  process  by  setting 

separate parameter group of laser, gas, delay and height etc. 

Available to regulate laser power and pulse frequency in real time. 

Allow user to save cutting technique of parameter group and reuse it to same 

material. 

Capable to memorize interrupted cutting and resume from given position. Allow user 

to select part of the drawing for cutting. 

Allow user to resume stopped/paused cutting from given position. 

Powerful  expansion  capability  with  up  to  30  PLC  process  and  50 

programmable items. 1

Support to appoint and program input and output ports. 

Support remote control via Ethernet by a wireless handle. 

1.2 Access, Update and Install Software 

You can contact your supplier to get software or download directly on Friendess 

company website www.fscut.com. 

Please confirm your computer environment meets the following requirements: 

1This function requires password and executed by trained professionals. 
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Win7 and later operating system. 

CPU I3 and above. 

4 GB memory at least. 

VGA display above 15 inches, resolution 1280*1024 and above, 32-bit true 

color. 

2 USB ports at least. 

If  your  operating  system  is  based  on  Vista  (including  Windows  Vista, 

Windows  7,  Windows  8,  Windows  2008  Server),  run  as  administrator  to  avoid 

potential errors. 

Make sure running environment meets the requirements then install the software. 

Under Vista-based operating systems it's required to run as administrator. 

To avoid program files modified during installation and ensure all drivers 

installed properly, please close anti-virus software temporarily. 

1.3 Start Operation 

1.3.1 Desktop Shortcut 

The shortcut icon will appear on desktop after installation complete. Double 

click CypOne desktop icon to run the software. 

The  below  image  will  prompt  during  startup  then  enter  into  CypOne  main  interface. 
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1.3.2 User Interface 



Friendess CypOne Laser Cutting Control Software 10

The black area in main screen is drawing board, the white box is machine-scaled 

working zone. The grid on drawing board and ruler will scale up and down when 

zoom the view. 

On the top are  Title bar and  Menu bar.  You can find most commonly used 

function buttons in menu bar, which are group-displayed in different tabs. There are

, Home, and CNC tabs in menu bar, click each tab switch the function display. 

At very top on left is Quick Access Bar, where you can create, open or save the 

file, and undo or redo the operation. 

On Left Tool Bar listed basic drawing functions. The first five buttons are used 

to switch different edit  mode, including select,  node edit,  sequence edit,  drag and 

zoom. Click buttons of different shapes you can create geometry on drawing board. 

The last 3 buttons used to center align, explode geometry and fillet corner. 

On Layer Tool Bar on the right displayed a Layer button and the other 17 layer 

buttons of different color. Click  Layer button will open 'Layer Parameter' window 

where users can setup most of the cutting parameters. Click color button to appoint a 

layer  to  selected  part  geometry,  and  this  layer  will  by  default  used  on  next  part 

geometry drew on drawing board. The part geometry appointed by the first layer 

will be shown in white color as a 'background layer' and not be processed in a cutting 

task. The last two ‘First’ and ‘Last’   layers indicate that to process the part 

geometry of ‘First’ layer at the very beginning and process the part geometry of ‘Last’ 

layer at very last. 

At  the  bottom is  the  information status  bar.  In  'Draw'  window displays  all 

messages of drawing operations. In 'System' window displays program messages apart 

from  drawing  operations.  Each  message  printed  with  time  tag  and  marked  with 
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different color so users can recognize these message as error, warning or notice etc. In 

'Alarm' window displays all alarm messages in red color. 

The status bar at the very bottom will display message to different operation and 

mode. The 'Fine Tune'  at  bottom right is  to move object  by direction button in a 

precise distance. The rightmost shows control card model. 

On the right side is  Control Panel where users execute most commonly used 

machining operations.  From top to  bottom are  coordinate  options,  manual  control 

buttons, machining control buttons, process options and production counter. 

1.3.3 Menu Bar 

CypOne tool bar displayed in Ribbon style that groups options in different tabs to 

facilitate user operations. The picture below will help you understand: 

There are two tabs of Home and CNC, click each tab open the sub-menu. There 

will be a third tab 'Working' when machine in a cutting process. 

In each tab the options are arranged in different function column like 'View' and 

'Transformation' etc. The buttons are large size for convenient operation. There might 

be small buttons like  under right corner of function column, click the button will 

open a dialog box. 

Click   under function button will open a drop-down list of more options. 
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Click the button will execute the function immediately, click drop-down button will 

open option list. 

If you are Office 2007, Windows 7, or other ribbon-style programs user, you may 

already be familiar with this arrangement.  Even you are first-time user will like the 

operation style. 

1.3.4 File Menu 

At the top on menu bar is File menu with an icon button, click  to open the 

file menu which contained options about file operations. 

The file opened recently will be listed in file menu where you can find your last 

opened file easily. 

You can save the file as lxds format by 'Save As'. 
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Click Import  to add new drawing to drawing board and preserve the existing 

drawing. Click Open to leave current workspace and open a new file. 

You can setup options related with user habits in ‘User Settings’. Click 'Backup' 

will backup machine config, PLC and user config parameters into a compressed file.  

Click 'BCS100 Monitor' will open BCS100 monitor interface. 'Diagnostic Tool' used 

for monitor software state and troubleshoot. 

Click 'About' at bottom corner will prompt a window showing detailed CypOne 

software information. 

1.4 Operation Flow 

1.4.1 Import Drawing 

Click   on quick access bar will open the File dialog box, select the file you 

need to open. The preview window on the right side of the File dialog will list the 

files. 
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You can also click  create new workspace and draw a part in CypOne with 

CAD tools. 

1.4.2 Optimize Drawing 

CypOne will automatically optimize the imported drawing - delete the duplicates 

and invisible shapes, join lines, smooth lines, sort and explode groups etc.  You can 

also customize the optimize features in File > User Settings > User Configuration. 

Normally,  the  geometry  figures  in  drawing  should  be  of  closed  contour. 

Otherwise the software will highlight the open figures in red color. This function can 

be turned off. You can check open figures in Home > View drop down menu by  

and  option. You can also select open figures by clicking Select > Select Open. 

You can break lines by Home > Optimize > Break Line, then click on the line 

where need to break. And join the lines by Optimize > Join Line. 

1.4.3 Technique Setting 

The  functions  under  Home  >  Technique  parameter  column  are  the  most 



Friendess CypOne Laser Cutting Control Software 15

frequently  used  options  in  machining  process.  Click   set  lead  lines,  click 

 set the over-cut, gap or seal features. Click  to add kerf width 

compensation. Click   add micro-joint tags which prevent parts from 

falling off the plate skeleton or tip-up collision with laser head. Click   

reverse the contour (cutting) direction. Click   and point on geometry to 

set start point. Or you can point outside the contour to create a lead line to the part. 

You can press Ctrl + A select all drawings, then click ' ' to set lead lines by user  

defined settings.  Click Lead drop-down > Check Lead Line, program will check if 

lead lines interfere with parts design and modify the lead line automatically. 

Click button   on layer tool bar to set  the detailed cutting parameters.  The 

Layer Parameters dialog box contains almost all the parameters related to the cutting 

performance. 

1.4.4 Toolpath Planning 

This process is to sort parts geometry and create cutting sequence. Click on 

Home > Sort will sort all geometries automatically. Or you can select in Sort drop 

down menu that fit your drawing layout. The software can identify the inner/outer 

relation in sorting. 
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You can click   on left toolbar to manually modify the sequence. Click one 

geometry  and  click  next  will  define  the  cutting  sequence  between  these  two 

geometries. 

You can click  group the sorted geometries to lock the sequence inside the 

group. The geometries inside this group won't be affected in other sorting process. 

Right  click  the  group  open  dialog  box,  select  'sort  in  group'  to  modify  the 

sequence inside the group. 

1.4.5 Pre-Check 

Users can check the tool path in several ways before start cutting on machine. 

Slide the process bar to skim the sequence or click ' ' to check the sequence one by  

one. 

Click  button on control panel or   in CNC tab will simulate 

the tool path in software. Users can adjust simulation speed click  and 

 in CNC tab. 
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1.4.6 Cutting Control 

Please take notice that it requires machine with compatible control card to realize cutting 

control. 

Before start  cutting you have to check relative position between drawing and 

machine  bed.  Click   on  control  panel  you  can  see  the  relative  position 

between cutting zone and machine bed. This relative position is calculated by part  

zero and laser head location. There are some symbols on the screen, click the 

Zero reference mark will move to the laser head position. 

If the red cross mark does not match the real position of laser head, please check 

the mechanic origin and correct the origin by CNC > Return Origin. If click  

on control panel, the drawing crossed white box on screen, it indicates the cutting 

zone will exceed machine bed. 

If the red cross does not match the real position of laser head, please check the 

mechanic  origin  and  correct  the  origin  by  CNC > Return  Origin.  If  click  '  '  the 

drawing  crossed  white  box  on  screen,  it  indicates  the  cutting  zone  will  exceed 
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machine bed. 

Click   in Home tab will  change the part  zero and relative position 

between cutting zone and machine bed. For example,  if  laser head located at  left  

corner to workpiece, you should select Zero Ref at left bottom. 

If  drawing  placement  fit  in  white  box,  click   in  control  panel, 

machine  will  dry  run  along  the  border  of  the  cutting  zone.  You  can  also  click 

 machine will dry run along tool path. 

Click  start machining, Click  pause the process and you 

can manual control laser head up and down, open or close laser and gas etc. In pause 

status users can click  and  to move laser forward or backward 

along tool path. Click  or resume the machining 

process. 

Click  end the machining process. Laser head will return to the pre-

set position. If you didn't change drawing or start new cutting, click can 

locate  to  interrupted  position  of  last  cutting  process,  click   resume 

cutting. 
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2. CAD Operations 

2.1 Features Display 

In Home > View provides various options to display technique and geometry 

features of drawing: 

Click the option you can see feature tags applied on drawing immediately. The 

option button in yellow indicates the option activated.  If  the option button not  in 

yellow color means function not enabled. For example,   is enabled, graphic will 

show the tool path with arrow symbol, close the arrow symbol disappear. 

Click  the drawing will display in center of white box. 

Click small icon   below View will open user configuration dialog box where 

you can customize more detailed effect like snap and ruler etc. 

Scroll the mouse to zoom the view. Click F3 will center drawing in white box, 

click F4 will center the white box in drawing board. Or you can do same operations 

by right click and open dialog box, select zoom > options. 
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2.2 Selection 

CypOne provides various ways to select  objects on drawing board.  The basic 

operation  is  'Click',  click  on  drawing  to  select  object.  Another  commonly  used 

operation is 'frame selection', drag the cursor on the screen will create a frame box to 

select object. There are 2 patterns of frame selection: drag from left to right will create 

a blue box, only when a whole part was framed in the box will be selected. Drag from 

right to left will create a green box, as long as part of the geometry was framed in the 

box, the whole object will be selected. 

The 'frame selection' effect of these 2 patterns shown below.  In left picture is 

effect of drag from left to right that only BC will be selected, in right picture is effect 

of drag from right to left that ABCD will all be selected. This selection method makes 

it flexible to select object. 

Press  Shift  when select  object  you can select  or  deselect  new object  without 

changing existing selections. 

Common operations: Select all (Ctrl + A), Invert selection, Copy (Ctrl + C), Paste 

(Ctrl + V), Cut (Ctrl + X), Deselect, Copy with base point. 

Geometric  operations:  Select  open,  select  similar,  select  all  outer/inner 

contour, or select objects smaller than specified. 

Layer operations: select a layer, lock background layer. 

Click 'forbid fast drag-copy' will not allow user drag any shape in drawing 

board or duplicate object by ctrl + left click operation. 
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'Select similar' is to select all objects of same shape and size with specified one.  

For example, select a circle of 5mm radius, then click 'select similar' will select all  

circles of 5mm radius on drawing board. 

2.3 Geometric Transform 

In Home > Transformation column provides options to modify geometry. Select a function 

option then select an object on drawing board to apply the effect like flip, rotate or align etc. 

2.3.1 Size Modification 

CypOne  provides  7  options  under  ‘Scale’  drop  down 

menu to quick modify the geometry size. Pictured as right: 

For example, '100mm' will scale the object with the size 

of 100mm, '2 times' will enlarge the object 2 times larger. 

Click  Scale  button  will  open  dialog  box  to  change 

geometry in precise size, input new size and click OK. 
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If the lock icon in this state , the scale of length and width is coupled, if you 

want to modify the length and width separately click the icon turns to this state 

 will unlock the linkage of two size input.

‘Scale  center’ specifies  the  relative  position  between  new  geometry  and  the 

original one. For example, ‘Top left’ indicates the object in new size will locate at the 

top left of the original one. 

Notice:  The lead line and kerf  compensation will  not  change with new sized 

geometry. 

2.3.2 Dynamic Transform 

In  CypOne  you  can  transform geometry  by  scale,  rotate  and  flip.  Select  the 

geometry on drawing board then click option button to finish the geometry transform. 

For example, to rotate a rectangle 45° in the base line of left bottom, you can 

follow the steps: 

1) Select the object. 
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2) Click Home > Transform > Rotate, in bottom information bar will 

prompt guide message ‘please specify basepoint: ’ 

3) Click left bottom of the object it will snap to key point: 

4) Click again in bottom information bar will prompt guide message 

‘input rotation angle: ’

5) Input 45 and click Enter will finish the operation. 

If you want to rotate the rectangle and align with another object, then follow the 

below steps: 

6) Click the right corner of rectangle will create a rotation base line. 

7) In bottom window prompts 'specify end point of rotation:  ‘Move 

the base line snap to key point and click. As below: 

Dynamic scale and flip operation much like the rotation, there will be no more 
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description here. 

2.3.3 Translate and Copy 

You can quick translate the geometry with direction button. Click  

button at bottom bar into activate status   and input a distance. Select 

object and click direction button will translate the object in preset distance. It allows 

you to move geometry in precise distance then return it  back to original position. 

Press Ctrl and direction key will duplicate selected geometry. For example, press Ctrl 

and right direction button, will create a duplication at right side 100mm to selected 

object. 

2.4 Parameter Input 

In  some  cases,  it  requires  coordinate  position  in  drawing  geometry.  CypOne 

allows user to locate position by input a coordinate, for example, (100, 100) input as  

100,100. Coordinates and parameters are shown in blue. 

Most of the drawing operations allow both mouse operation and parameter input 

method.  The following steps show you how to draw a rounded rectangle of length 

300mm, width 200, with fillet radius 25mm. 

1) Click   select  at left toolbar, meanwhile bottom 

window will prompt 'Please specify start point'. 

2) Input ‘0, 0’ press enter, then prompt' please specify cross point'. 

3) Input '300,200' press enter, prompt' please specify radius'. 

4) Input  50  press  enter.  All  operations  are  completed.  As  shown 

below. 
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2.5 Snap 

CypOne will activate ‘snap to key point’ like grid or geometry border in some 

operation. 

You can turn off the snap function in  > User Settings > User Configuration > 

Drawing board, deselect option. The snap precision can be 

set in same dialog box. 

2.6 Draw 

CypOne provides CAD tools on left tool bar, from top to bottom are: point, line, 

polyline, circle, arc, rectangle, polygon and text. Drawing operations are similar with 

CAD. 

2.6.1 Standard Shape 

Drawing shapes of circle, rectangle and other is quiet simple. There will be no 

more descriptions here. There are two special options in Circle menu: 'Replace circle 

as point' and 'Replace by circle'. The former one can replace circle as point, the later 

one can replace selected object as circle. 

In Polygon menu provided rectangle, rounded rectangle, polygon and star shape. 

To draw a rounded rectangle, you need to draw a rectangle then specify the round 

corner radius. To draw a polygon or star shape, you have to specify the edge numbers 

(from 3 to 100). Edge number also indicates star tips. 
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2.6.2 Text 

Text can be transferred to curve in CypOne. Click  on left tool bar then type in 

text on target position.

On top menu bar will display Text tab and options where you can modify content, size and 

style of text. As below: 

The content and style of text cannot be changed once it's transferred to curve. 

After you finish all design and settings of the text, transfer the text to curve as last 

step. 

2.7 Measure 

Measure tool is to measure the distance between two points. 

Click  in Home > Tools and point two points on drawing board, the distance 

between points will display in bottom window. 
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2.8 Optimize 

CypOne will optimize the imported drawing. You can also modify the drawing by 

Home > Optimize options: 

Select  a part  geometry and click optimize option then finish the operation by 

prompted guider. 

2.8.1 Smooth Line 

Select a geometry and click 'Smooth Line' will open dialog box, input smooth 

precision click OK will apply to selected object immediately. 

The  comparison  between  original  and  smoothed  geometry  shown below.  The 

example here put a large value of precision to make comparison visible, user has to 

input precision value as needed. 
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2.8.2 Break Line 

‘Break Line’ is to break a closed geometry or open figure into segments. Click 

'Break Line ' and point on geometry. Break function will keep functioning until switch 

to other command or press ECS turn off the function. 

2.8.3 Delete Invisible 

There are unneeded geometries too small  and invisible in a drawing that  will 

cause laser head located to a strange position in cutting. Click in Home > Optimize > 

Delete Invisible, then define the size of the shapes to be deleted. The shapes smaller 

than specified size will be deleted while others preserved. 

2.8.4 Delete Duplicate 

Lines of geometry lying together make it visually look like one line which cause 

unnecessary and repeated cutting damage the workpiece. Click 'Delete Duplicate ' will 

delete the duplicates by given tolerance. 

2.8.5 Join Line 

There are lines visually connected but not joined and hard to identify even zoom 

close. Select geometries and click 'Join Line' can join all line segments within given 

tolerance. 
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In some cases you have to delete unnecessary lines then join line segments. 

2.8.6 Break Grid 

This function used to cut large in-part waste into small pieces falling down to 

prevent tip-up collision. The cutting line shown in white color. 

2.9 View 

You can zoom and adjust view, edit drawing or modify sequence in this module. 

Function entry is on the top of the left toolbar. From top to bottom is select, node edit, 

manual sort, hand tool and zoom. 

2.9.1 Node Edit 

You can adjust the drawing precisely by node editing. Click  then select 

geometry you can see nodes on drawing. Drag the node to adjust the drawing. 

Click  again will disable the function.
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Nodes in blue and yellow both are editable. 
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3. Technique Setting and Tools 

The chapter describes the techniques in laser cutting. You have to set the cutting 

technique fit your cutting condition considering that the actual cutting performance 

directly related with material, laser and gas etc. All parameters should be considered 

as reference not a guide value. 

Improper or  incorrect  parameters  may result  in bad cutting performance even 

damage the machine. 

3.1 Lead Line 

3.1.1 Inner & Outer Contour 

CypOne can identify the inner and outer contour of part geometry automatically. 

After  modify  the  part  geometry  the  inner/outer  relations  will  change,  click 

 in  ‘Sort’  drop  down  menu  will  identify  the  inner/outer 

relation of changed part geometries. 

The principle to identify the inner/outer relations in CypOne works like this: the 

outmost  contour  is  outer  contour  and next  to  it  is  inner  contour,  open figure  not 

considered in. If you want to specify an outer contour within a part geometry, group 

all shapes inside this contour and set sequence within this group. 

Lead line introduce to part from outside outer contour, inside from inner contour. 

Select a contour and click  and  to change contour relation. 



Friendess CypOne Laser Cutting Control Software 32

3.1.2 Auto Lead Line 

Select objects and click  in Home tab open the dialog box like below: 

There are three styles of lead line including line, arc, arc + line, each style is  

available to define the lead length and lead angle. It's also available to add small circle 
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on lead line. 

The front end of arc style lead line is always tangent to part geometry. The lead 

angle of arc is the angle between part geometry and the line connected two ends of 

arc. Lead out line of arc style is similar with this principle. 

If you select lead position will change lead position and type of previous lead 

line. You can select  to preserve the lead position of 

preset lead line. 

3.1.3 Manual Lead Line 

Click   to manually change lead line. Click on part geometry will change 

lead position while maintain the length and angle.
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Or you can create a lead line by . Click and drag a line to part geometry will 

create a lead line. 

3.1.4 Check Lead Line 

Click  ‘Check  Lead  Line’ under  ‘Lead’ drop  down  menu  software  will  check  lead  line  

interference  with  part  geometry  and  modify  the  length  automatically.  Click  'Identify 

inner/outer  contour'  software  will  adjust  lead  line  direction  by  identified  contour 

relation. 



Friendess CypOne Laser Cutting Control Software 35

3.1.5 Over, Gap and Seal 

There are four options under   drop down menu . Select 

part geometry and click option to add features. 'Gap/Over' setting only take effect to 

selected objects, the previous setting of other object doesn't change. 

3.2 Compensate 

Select part geometry and click  open dialog box. 

Kerf width compensation accessed by measuring and comparing cutted part and 

part design. The new path of compensation is white color and machine will follow the 

compensated tool path. Origin contour of part geometry still preserved on drawing 

board for comparison. 

The compensation is inside or outside (expand or shrink) part shape identified by inner/outer  

contour relation, also user can select options. 

You can select to round the corner of compensated tool path. 
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In the image, the white line is compensated tool path, yellow line vertical to compensated 

path.  The compensated corner is rounded. The rounded corner can guarantee smooth 

cutting. 

Click  drop down list to edit and save commonly used kerf 

width options. 

You can choose if to compensate open shapes or preserve original toolpath. 

Select objects you want to delete compensation then click   will 

delete the compensated path. 

3.3 Micro Joint 

Micro joint is a gap of small distance on part geometry, the gap won't be cut in process and 

keep part attached to plate skeleton, which can avoid tip-up collision. The laser doesn't fire in 

the path of micro-joint. Micro joint featured as a gap on part geometry on drawing 

board. 

Click  open dialog box set the length, click on part geometry will 

apply micro joint feature, and you can apply this feature multiple times until press Esc 

cancel the command. Micro joint can apply to compensated path. 

Apart  from  add  micro  joint  one  by  one  on  part  geometry,  you  can  apply 
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automatically by parameter setting. Click  in drop down menu open 

dialog box.  There  are  two patterns  of  adding micro joint:  by total  number  or  by 

interval. For example, you can choose to add 10 micro joints to each figure, or add 

micro joint to part geometry every 100mm interval. 

Click  in drop down menu will break micro joint from tool path. 

Exploded micro joint is editable and available to add lead line as individual figure. 

To delete micro joint, select the objects and click  in 'Clear ' drop 

down menu. Or activate micro joint function press Shift button and click on micro 

joint tag can also delete it. 

3.4 Fillet 

Click  then point on part corner will round sharp corner by preset radius. 

Select part geometries then click  left tool bar can add fillet to all selected objects. 
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3.5 Group 

If you 'Group' multiple geometries, the group will be identified as one object. The 

sequence and layer inside group will be locked and won't be changed when you drag 

or sort part. 

Select the geometries and click  can create a group. Select group and click 

 will  explode group into individual  shapes.  Click  in drop down 

menu will explode all groups on drawing board. 

Only explodes group into individual shapes, it will not break lines of closed 

geometry. will explode shapes and lines into segments.

The shape contains all  other shapes in a group will  be identified as the outer 

contour of a part. 

Users have to group shapes by the logic of part geometry, which means only the 

shapes consist of a part should be grouped together. The terms 'group' and 'part' in 

CypOne indicates same meaning most of time. 

CypOne will group the common line geometries automatically for its integrity. 

The geometries applied 'Bridge' also be grouped automatically. 

3.5.1 Sort in Group 

A group in sorting process is  identified as one single object,  the sequence of 
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shapes inside a group will not change. 

If you want to modify sequence of shapes inside group without explode it, right 

click group and select 'Sort in group'. 

There might be group inside a group, 'sort in group' will not change the sequence 

of  shapes in  sub-group inside a  group.  The sorting approach inside a  group only 

relates with geometric relations not to do with layer of shapes. 

3.5.2 Process of Group 

Group will be identified as an independent object, until a group finished cutting it  

will not move on to the next part drawing. Piercing process to a group also follows the 

same rule. 

Please notice that the outer contour of part design should always cut at last, sort 

the part design set proper sequence before cutting. 

3.6 Fly Cut 

For parts of regular shape arranged in array pattern, apply Fly Cut can profoundly 

improve cutting efficiency. Fly Cut is a high-speed cutting technology. Laser head 

performs the cutting without interruption at a continuous speed which makes it looks 

like floating on sheet. 

Sort the part geometries then create fly cut path can optimize fly cut path. 

Click   in Home tab open dialog box. If  selected geometries are circles, 

dialog box would be 'Circular fly cut' otherwise it's 'Linear fly cut'.

Start position defines where to start fly cut. Joint interval is that when fly cut path 

make a turn, when interval to next row of shapes smaller than this distance can be 
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connected. Allowed space is that when space between two objects longer than this 

value won't create fly cut path between them. 

When all geometries are circles, select 'circular fly cut' open dialog box setting 

parameters. 

Allowed space means that  when space between two circles larger than this it 

won't create fly cut path. 

Click 'Sort' software will sort part geometries first then create fly cut tool path.  

Click 'Cut by part' the toolpath will follow the principle of finish cutting of a whole 
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part then start next. 

There is a parameter ‘FlyCut overcut’ in ‘Global Parameter’ window to add extra cutting at  

the end of each part to make sure parts are fully cut off.
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3.7 Co-edge 

Merge the shared line of two parts as one will 

reduce  the  total  cutting  length  and  improve 

efficiency.  In  CypOne,  the  geometry  borders 

between which gaps smaller than 1 mm can merge 

as common line. Drag a shape close to another one, 

it will snap to the geometry border. 

Select  the  objects  and  click   to  create 

common line. 

Curve  shape  cannot  create  common  line  in 

CypOne. 

The geometries merged common lines will be integrated as a group.  If the part 

design has in-part geometries, group the shapes within this part then make common 

line, otherwise software cannot identify geometry relations and sequence. 

3.7.1 Auto Snap in Co-edge 

When  drag  a  part  geometry  close  to  another  in 

CypOne,  it  will  snap  to  key  points  or  border  in 

tolerance  range.  Snap  can  help  to  place  two 

geometries together in common line application. Snap 

also works for multiple geometries drag together. 

Once  two  geometries  share  the  border,  click 

 will merge the shared edge as common line.  If 
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you  want  to  edit  geometries  applied  common  line,  click   under 

‘Group’ drop down list to explode common line geometry. After modify the individual 

shapes then group them again. 

3.7.2 Co-edge with Compensation 

If  you  want  apply  kerf  compensation  to  common line  geometry,  compensate 

before co-edge the geometries.  Co-edge won't  change geometric shape in merging 

common  line.  If  the  part  geometry  applied  kerf  width  compensation,  only 

compensated path will be left on drawing board after co-edge. 

For example, in above image, A is original design, P is compensated path to A, it's 

P and B co-edged as common line.  Even if move B close to A still cannot co-edge, 

because A is not tool path anymore. 

3.8 Bridge 

Bridge usually applied to connect the parts with separate figures, usually used in 

text  character  cutting.  The  part  geometries  connected  by  bridge  also  reduce  the 

piercing times. You can apply bridge on part design multiple times to connect separate 

shapes. 

Click  open dialog box, set the parameters and drag a line between shapes 
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you want to connect. Like below: 

There are two options to define bridge- effective distance and bridge width. The 

former one decides that only between lines of distance within this value can apply 

bridge, the later one decides width of bridge. 

Please  take  notice  that  separate  geometries  connected  by  bridge  will  have  a 

continuous cutting which can be affected by thermal distortion. 

3.9 Array 

This function can create duplications in a user defined array. 

3.9.1 Rectangular Array 

Click   or  under Array drop down menu will open the dialog 

box: 
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Set  the  row  and  column  numbers  and  other  options  click  OK  will  create 

duplication in defined array. 

3.9.2 Dynamic Array 

Click  open the dialog box, setup the interval of rows and columns, 

then drag an area to create duplications. Like below: 
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3.10 Batch Modify 

You can apply changes of one geometry to similar geometries by batch modify to 

improve efficiency, take an example: 

Select a geometry and enter in batch modify window, set lead line, the changes 

will apply to all similar geometries of same shape and size. 
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3.11 LED Matrix 

LED Matrix used to fill circles inside geometry by user defined style. Fabricators 
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in  advertising industry need to  cut  circles  on workpiece put  LED lights.  CypOne 

provides easy ways to design these circles on part geometry. 

3.11.1 LED Matrix Filler 

LED matrix filler can apply to all closed shapes. Select a shape and click  in 

Home tab open the following dialog box. 

The  radius  defines  circles  size,  margin  means  the  gap  between  border  and 

outmost circles. There are 5 style options to create circles layout pattern. 

3.11.2 LED Matrix Tool 

LED Matrix Tool used to adjust layout of filled circles. Click   in 

LED Matrix drop down menu will open dialog box. 
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Set the circles interval distance and margin then click , drag an area on 

drawing will apply changes to circles inside selected area. Click  then drag 

an area on circles will delete the circles in this area (only apply to circles made by  

LED Matrix).  is to check the circles number and layout within a selected 

area. 

3.11.3 Divide 

The advertising decoration can be larger than machine bed in size of  meters, 

fabricator has to divide whole drawing design into smaller shapes fit to cut in machine 

then put cutted pieces together. 

Click  open dialog box. Mark is to add mark of number and letters at 

divide end make it recognizable to pick up and put together cutted pieces. The mark 

will be appointed as marking layer. Select   will group the divided 

shapes in case of messing up the design. 
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3.11.4 Curve Measure 

Click function button and define a curve segment by appoint start and end point. 

The curve highlighted in yellow is to be measured, the length result will be shown in 

bottom Draw window. 

3.12 Technique Parameter 

There are 16 layers in CypOne, users can set the cutting parameters to each layer 
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including cutting speed, laser power, gas pressure and nozzle height etc. The last two 

layers are 'First' and 'Last' which means to process at very first and at very last in 

sequence. 

Click   in Home tab or   aside control panel will open 'layer parameter' 

dialog window contains all cutting parameters. The first tab 'Global parameter' listed 

motion  control  parameter,  laser  burst  parameter,  default  gas  blow  parameter  and 

follow actions parameter etc. In all layer tabs listed cutting and piercing parameter 

groups, click and open each layer tab set parameter separately.

Notice:  In 'Layer Parameter' dialog window will display different parameters by 
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laser  and  gas  configuration.  The  parameter  in  demonstration  image  is  only  for 

reference. 

3.12.1 Parameter Description 

The following table gives a brief description to some of the layer parameters. ① Basic parameters

Cut speed The  target/command  cutting  speed,  while  the  actual 

cutting  speed  is  under  this  value  considering  the  speed 

change in corner turning, or in start and end phase in a tool 

path segment.

Lift height After  finish  a  tool  path  segment,  laser  head  lifts  and 

locates to next start point of tool path segment. When pause 

the cutting, laser head also lifts and holds to this height.②Cutting parameters

Nozzle height The standoff distance between nozzle and plate surface 

in cutting.

Gas type Gas type in cutting.

Gas pressure Gas pressure in cutting. Pressure regulation requires DA 

gas valve signal given by CypOne.

Peak power The peak power decides the maximum power in cutting. 

Take  an  example,3000W laser  source,  peak  power  set  by 

80%, the maximum power in cutting is 3000 * 80% =2400W.

Duty cycle The  duty  cycle  of  PWM  laser  modulation  signal  in 

cutting. 3000W laser, peak power 80%, duty cycle 80%, the 

average cutting power is 3000*80%*80%=1920W.

Pulse frequency The  pulse  frequency  of  PWM  modulation  signal,  it 
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defines  laser  fire  times  in  one  second,  higher  frequency 

indicates more continuous laser wave.

Focus position The relative position between laser focus to nozzle tip.

Laser on delay The  laser  fires  duration  before  start  cutting  to  burn 

through a small hole on material.

Step time The  time  spent  that  lower  from  pierce  height  to  cut 

height.

Laser off delay The delay to turn laser off to make sure cutting totally 

finished.

Extra blow The extra gas blow after pierce finished and laser turns 

off to cool down the material.③ Other parameters

Not cut The parts drawing of this layer doesn't cut.

Not follow Laser  head holding in  fixed height  in  cutting,  now to 

follow a constant distance with plate surface.

Gas on Gas is open in the whole machining process.

Reduce lift This function has to work with another parameter 'Unlift 

when travel shorter than' in global parameter. When finish a 

toolpath  segment,  if  the  travel  distance  to  next  start  point 

shorter  than  this  value,  laser  head  doesn't  lift  and  move 

directly to next start point.

Pre-pierce Finish all pierces at start point then start cutting. There is 

'auto group pre-pierce' option in global parameter dialog box. 

Note: this option cannot work with defilm together

Defilm Execute  defilm  cutting  along  toolpath  first,  then  start 

cutting. Enable this function will open a parameter window 
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for setting defilm parameters.④Slow start

Lead length This used in cutting thick material, it will start cutting in 

a slow speed to make sure plate cut through.

Lead speed The speed in this slow start length.⑤ Power curve

Laser 

Power/Frequency 

Regulation

After  you  enable  this  function  you  can  edit  the 

power/frequency curve, and program will regulate the laser 

power and frequency according the curve. This function is 

very  practicable  improving  corner  precision.  Notice: 

Frequency  regulation  curve  must  be  used  with  power 

regulation curve.

3.12.2 Laser Power/Frequency Regulation 

If  enabled  ,  CypOne  will  regulate  laser  frequency 

and duty cycle in real time by speed change by preset curve scale. Click  

to edit power/frequency regulation curve. 
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In above image, horizontal axis is cut speed, vertical axis is laser power/pulse 

frequency, and the unit is percentage %. You can click on curve to add nodes or copy 

the power-speed scale curve to pulse frequency- speed scale. When cut speed reaches 

to one point in horizontal axis of scale curve, laser power and pulse frequency will be 

regulated in real time coincidence to the vertical axis of scale curve. Notice: Pulse 

frequency curve must works with power curve, means you have to enable both scale 

curve. 

For example, laser power 500W, preset cut speed 100mm/s, peak power 90%, cut 

power (duty cycle) 80%, when the real cut speed lower to 60% of target cut speed,  

CypOne will regulate laser to: 

500W X 90% X 80% X 60.00% = 216.0W 

The power will not be lower than 10% of the laser power, for example 500W 

laser will not lower than 500*10%=50W. 

If  not select   , the cut power will  remain same in 

cutting process. In the above example, the power in the cutting process remains 500 

W X 90% X 80% = 360W. 
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3.12.3 DXF Layer Mapping 

In drop down menu listed more options for layer operations. When there are 

more than one layers in DXF drawing, click can appoint DXF layer 

to CypOne layer of cutting technique. Like below image, DXF layer appointed to 

CypOne layer for different technique. 

3.13 Nesting 

Nesting  is  to  arrange  parts  geometries  in  plate  with 

highest  utility  with  benefits  of  reducing  waste  and 

optimizing tool path. CypOne simplify the process to allow 

nesting complete by a few clicks. 

3.13.1 Nest 

Import part drawing and select the objects, click  

open dialog box setup plate size,  margin and part  gap will 

complete nesting. 
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'Parts gap' is the minimum space between parts; 'Plate margin' is the empty space 

left on plate border. 

After nested parts, there will be a nesting list on left side where lists both drawing 

design and nesting results. 

CypOne supports up to 100 parts and 20 plate nesting. 

3.13.2 Sort and Tool Path 

In Home > Sort listed function buttons for sort and align parts geometries: 
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Related  content  on  sort  please  refer  to  'Group'  section.  If  no  special  sorting 

requirements it's recommended just select 'Grid Pattern'. 

3.13.3 Sequence Preview 

Drag the progress bar or click  you can preview the machining sequence of the 

part geometries. Below picture shows the status of a part in previewing sequence: 
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This process is interactive can be controlled freely, you can only check sequence 

in selected area back and forth. Click  under Home > View 

will display overall tool path sequence. 

3.13.4 Manual Sort 

If you want to adjust parts sequence, select the objects then click from these four 

buttons: 

First Selected figure put as the first.
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Last Selected figure put as the last.

Forward Move selected figure forward one step in sequence.

Backward Move selected figure backward one step in sequence.

After finish sorting, you can click  to check the sequence one by one. 

You can also click  on left tool bar enter 'manual sort mode' to set sequence 

one by one.  The sequence number tags on each figure and tool  path will  change 

accordingly when you modify the sequence. Just click one figure then point next one 

will define the sequence between them. If you point wrong object in sorting, click on 

this wrong object again to cancel last command or right click > cancel. If you only  

want to change sequence between two objects, click one then drag a line to the other. 

As shown below. 



Friendess CypOne Laser Cutting Control Software 61

3.13.5 Group Sort 

If you want sequence of some objects fixed and not to be changed, select the 

objects and 'Group' them. Other manual sort or auto sort process won't change the 

sequence inside group. Until all figures inside a group completed laser will move to 

next object outside the group. 

If you only want to change sequence of some of the objects not affecting others,  

you can also do it by group the objects.  Change the sequence inside group by right 

click it and select 'Sort in group'. 
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4. Cutting Control 

CypOne integrates CAD and CAM in one, all CAD operations can finished on 

your laptop in office as well as cutting technique setting, then send file to machine for 

cutting. 

4.1 Coordinate System 

The 'modeling coordinate' in designing part geometry is not relevant to machine, 

part zero marked by  on drawing board. The coordinate relation in drawing and 

machine bed illustrated below: 

Click   on control panel will display position relation between drawing 

and white frame which indicates the cutting area relative to machine bed. 
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4.1.1 Mechanic Coordinate 

Mechanic coordinate is a unique existence decided by mechanism and machine 

config.  Coordinate  created  any  time  after  return  origin  is  consistent.  If  mechanic 

coordinate deviated, click   in CNC tab to reset coordinate. 

The  definition  to  coordinate  in  CypOne  is  same  no  matter  what  mechanism 

structure  is.  In  CypOne  definition,  laser  head  moves  right  to  workpiece  is  X+ 

direction,  laser  head  moves  back  towards  workpiece  is  Y+  direction.  Hence  the 

bottom  right  in  workpiece  located  smallest  coordinate  value,  the  top  right  in 

workpiece located biggest coordinate value. 

4.1.2 Software Coordinate 

Mechanic coordinate is fixed, CypOne adopts 

software coordinate that facilitates the production. 

The  direction  of  CypOne  software  coordinate 

same with mechanic coordinate,  only zero point 

different.  Software  coordinate  contains  float 

coordinate and workpiece coordinate. 

You  can  select  coordinate  on  top  of  the 

control  panel,  there  listed  'float  coordinate',  nine  'workpiece  coordinate'  and  one 

'external coordinate'. 

Float coordinate used in small quantity parts production, laser will start cutting 

from where it stands. Execute 'Frame', 'Dry Run' or 'Start', part zero will be current  

position of laser head. 

User  can  appoint  a  zero  point  manually  to  each  workpiece  coordinate  1-9. 

Workpiece coordinate applied in large quantity production, sheet material of standard 
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size will  be placed same position on machine bed. Use workpiece coordinate can 

mark a fixed zero point that guarantee cutting starts from same position on sheet every 

time. 

Click   at  the  very 

bottom  to  select  display  mechanic  or  software 

coordinate  in  CypOne,  you  can  also  specify  zero 

point  here.  Select  'coordinate  locating'  locate  the 

cutting head to the specified coordinate position. 

4.1.3 Find Part Zero after Exception 

Situation 1 

If machining process stopped by the accident like gas or laser exception which 

doesn't affect coordinate system, click  can locate to part zero. 

Situation 2 

If  accidents  like power down or  servo alarm stop the machining process  and 

deviate the coordinate system, must execute return origin reset coordinate then click 

 locate to part zero. 

4.2 Alarm 

CypOne monitors alarm signal and core components status, it will stop machining 

once received alarm signal or detected alarm condition and display alarm message in 

red  color  on  top  title  bar.  Most  of  the  motion  functions  are  disabled  until  alarm 

released.  Please check the machine by alarm message,  make sure alarm condition 
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solved then start cutting. The alarm title shown as below: 

The 'Alarm' window at the bottom also displays the alarm message. After remove 

the alarm source the alarm in title bar will  disappear but alarm message in alarm 

window all saved. Double click 'System' window can check all history records and 

software events. 

Besides alarm CypOne will detect other working condition and display warning, 

notice and message in different color in 'system' window. These message won't stop 

the machining but still suggest take notice of it and take precautions in advance. 

The  alarm can  be  released  automatically  or  manually.  The  following  are  the 

limitations to some alarms: 

 Disable servo motor when emergency stop alarm activated 

 Disable X/Y motion functions when BCS100 alarm detected (under 

this status, Z axis condition unknown, there are collision risks if X/Y move) 

 Disable XYZ motion function when emergency stop alarm activated 

(in complete stop status) 

 Z limit- alarm, disable dry run and jog. 

4.3 Manual Test 

The manual control buttons on control panel listed below: 
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The button  will turn to  once activated. Press  will turn on laser, 

release button turn off laser. For other buttons, click the button activate the function,  

click again close the function. For example, click   open the gas, click 

again close gas. For different laser model, there will be a delay click  till 

it turns to . This status accessed from laser source. Click will 

open guide/pilot laser beam. 

These buttons work with hardware on machine to function. If hardware damaged 

or not properly set configuration in machine config tool, button doesn't function. 

Click  to mark the current position, click  if you need to 

locate to the mark position. User can set 6 markers select from . 
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4.4 Soft Limit Protection 

CypOne  can  limit  machine  travel  range  by  software  limit,  click 

 on control panel will enable the function. 

When CypOne calculates the cutting zone of drawing will exceed travel range, it 

will prompt 'motion out of range' message and forbid sending motion command to 

avoid collision. Check the part zero setting and adjust laser head position. 

System will monitor the current position in real time and stop the motor function 

once detected laser exceeded soft limit range. 

Notice: soft limit protection relies on correct coordinates. Therefore, every time 

after  change  the  machine  config  or  system  abnormal  shut  down  happens,  must 

execute return origin to reset coordinate. 

4.5 Frame 

Click  laser head will run the outline of the cutting zone in a frame 

box. It helps to identify if the cutting will exceed plate. Frame speed set in Layer 

Parameter Window > Global Parameter > Frame Speed. 

Notice:  If  execute  'Find  Edge'  process  before  frame,  CypOne  will  offset 

coordinate with the angle of plate, frame path also runs in a angled box rather than 

square box. 
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4.6 Start and Dry Run 

Click   on  control  panel  start  cutting,  the  working  status  bar  will 

display on top monitoring coordinate, speed, time and follow distance etc. 

The working status bar cannot switch to others during a cutting task in case any 

operations change the part drawing. If you need change parameter please pause the 

cutting first then open layer parameter window modify the parameter.

Click   machine will run the tool path not turning on laser and gas, 

while the speed and path are same with actual cutting. In dry run you can also execute 

pause, resume, forward, backward and even locate break point, all  same with real 

cutting process. Dry run used to fully check and simulate the whole cutting process. 

You  can  choose  to  enable  in  Layer  >  global  parameter 

window.

By default laser will go to zero point after cutting 

finished, if you want laser goes to other position after 

cutting  you  can  select  in  control  panel 

 ,  options  including  part  zero, 

start position, end position, origin and marker. If   not selected, 

laser head will stand where the cutting finished which equals to 'end position'. If you 
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use  'float  coordinate',  it's  recommended  to  choose  laser  goes  to  'zero  point'  after 

cutting. 

After finish the cutting of one drawing, the counter on control panel will add up 

1, when reach the planned cutting times of one drawing will prompt message dialog 

box to notice user. Click  open dialog box setup the production schedule 

and auto pause. For loop cutting task, click  to finish setup. 

4.7 Stop, Pause and Resume 

Click  or  on control panel to stop a cutting task. Laser head will 

stand at where it stopped. 

Click  or  on control panel to pause a cutting task. It's allowed to 

change some of the cutting parameters in layer window, or you can execute manual 

functions in control panel like burst laser and gas blow. 

Click  on control panel will resume the cutting from paused position. 

Click   will  skip  pierce  process  and  cutting  from  paused 

position directly. 

Click  or  laser head will step forward or backward along 

the tool path, the step distance set in   on control 

panel. 
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4.8 Breakpoint 

When cutting process stopped or interrupted by accidents, as long as not changing 

any  cutting  parameters,  you  can  click   locate  to  break  point.  Click 

locate to break point and resume cutting. 

If you change the cutting parameter of stopped/interrupted cutting process, the '

will change to  which means resume from breakpoint is not 

available. 

4.9 Start from Given Position 

CypOne allows user starts cutting from given position of drawing. Right click on 

drawing, select 'start from here'. Shown in picture: 

For  safety  concern,  select  '  ',  program will  prompt  dialog  box  asks  users  to 

confirm operation again. Then laser head will locate to the specified position start  

cutting. 
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If select ' locate here', laser head will locate and pause at given position. 

You can execute 'locate here ' multiple times to confirm location is right. Or you 

can adjust start position more precisely by   and . 

4.10 Global Parameter 

The parameters  setting  in  'Global  Parameter'  window will  affect  the  machine 

running condition, workpiece cutting performance and efficiency. 

① Motion control parameters

X,Y traverse speed Traverse speed is the rate at which machine positioning in 

between cuts (different with cut speed0.

Traverse acceleration The  maximum  traverse  acceleration  in  traverse 

movements.

Frame speed Speed when laser head execute Frame function.

Cut acceleration The acceleration in cutting.

LFP(Low-pass filter) The  rate  that  cut  acceleration  changes  with  respect  to 

time.

Default settings

Burst pulse frequency PWM pulse frequency when burst laser via CypOne control 

panel.

Burst peak power The peak power when burst laser.

Manual gas blow The gas pressure when click Blow in CypOne panel.

Gas on delay Delay to gas on in default PLC process.

First gas on delay Extra delay added to gas on delay when start cutting and 
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execute gas blow the first time.

Switch gas delay The time required to make sure old gas totally discharged 

and new gas comes in to channel when switch the gas.

Back when resume When  resume  the  paused  cutting,  laser  head  will 

move backward a distance then start cutting.② Follow parameter

Max follow distance There  is  an  effective  capacitance  sensing  range, 

which means follow distance in this range is accurate. If 

follow distance larger than this value, laser will follow to 

this limit distance first then lift up to target distance.

Frog-leap lift Laser head will lift up to given height then travel to next 

when finish cutting of one tool path segment, this function can 

optimize lift action to reduce the travel time needed.

Follow in dry run By default,  laser  head doesn't  follow to plate  in  dry run. 

Select this option if you need laser head follow to plate in dry 

run.

Disable follow In  a  standard  cutting,  laser  head  tip  will  follow to  plate 

surface and maintain a constant distance. If you need laser head 

cutting in fixed height not follow to plate surface just select this 

option.

Shelter alarm in pierce Shelter the capacitance alarm in piercing.

Hold at fixed height This option used in non-metal cutting, laser cutting 

in a given height above plate surface rather than follow 

and maintain a constant distance.

Unlift  when  travel 

shorter than

When laser finished one segment tool path cutting, it lifts up 

then  travel  to  next  tool  path  segment.  If  the  travel  distance 
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shorter than this value, it doesn't lift up and keeps follow to next 

tool path segment.

Unit selection Select the unit system by user’s habits.③Advanced

NURBS interpolation Select  the  option  CypOne  will  optimize  tool  path 

smoothness by nurbs fitting.

Compensate precision Precision of kerf width compensation.

Fly Cut overcut Add an extra distance to the end of the fly cut tool 

path, make sure parts fully cut off in high speed cutting.

Auto group pre-pierce By default  laser  will  execute piercing to grouped figures, 

then  to  others.  If  no group in drawing,  laser  will  finish 

piercing of all figures then start cutting. Select this option, 

laser  will  execute  both  piercing  and  cutting  of  one  part 

geometry then locate to next part.
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5. CNC Assist Function 

5.1 Simulate Process 

User can simulate whole cutting sequence in software after finish nesting and 

sorting of part geometries.  This operation doesn't require machine tool involved. By 

simulating you can see part to part cutting sequence and in-part cutting sequence. 

Click  in control panel, it will switch to 'CNC' tab automatically, you 

can adjust simulating speed in tool bar. 

5.2 Find Edge 

CypOne allows user manually locate plate edge by targeting 2 points on plate 

border. 
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Choose one side of plate, then locate laser head to P1 and P2 position save the 

setting, software will calculate the plate placement angle and offset into coordinate 

automatically. 

5.3 PLC Process 

Click   in CNC tab open PLC editor, you can customize and execute PLC 

process. 

Notice: improper PLC settings will cause severe consequence! 
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5.4 Return Origin 

Click   in  CNC tab  will  return  motor  axes  to  mechanic  origin  and reset 

coordinate. Or return single axis return origin by options under ‘Return Origin’ drop 

down menu by select   and . When click   will  return 

laser head (Z axis) first, then follows X and Y.

5.5 Diagnosis Tools 

You can open Main I/O monitor in  in File menu during a 

cutting to check status of functioning parts involved. 

In left zone displays each motor axis number and pulse feedback from encoder. 

User can send given pulse commands to single axis motor check if pulse equivalent 

set right. Limit monitors if laser hits the limit sensor. PWM monitors laser status of  
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turning on/off. It also monitors active status of 6 input ports and 8 output ports. 

5.6 BCS100 

Click  in File menu open the BCS100 control panel where you can 

execute return origin, follow, locate and calibration etc. 

5.7 Error Measure 

Click   laser will dry run along the tool path. CypOne will display motor 

path in blue color with command path as comparison, by which you can adjust motor 

and cutting parameters.
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6. Appendix 

6.1 Co-edge Example 

Below  is  the  co-edge  example.  On  right  side  is 

original design of DXF file. 

Open figure highlight in red color which also the lines to 

merge as common line. 

There  are  6  bigger  parts  and 10 long strip  parts  down 

below, and 9*2=18 short strip parts at right side. 

First,  separate  these  3  parts  from  original  design.  As 

below: 

Select all shapes of one part then group them. 
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Select this part then create a 3*2 size array. 

Select 6 parts in array, click  will merge as common line design. 

Then drag part 2 close to part 1, it will snap to key point. As below: 

Select part 2, create a 2*9 size array. Select all 18 part 2, drag from left to right 

can avoid part 1. 
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Click  will merge all part 2 as common line. You have to take notice here 
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that cutting has to start from right to left, otherwise the plate in this area will deviate  

or vibrate because lack of support from plate skeleton. 

Right click part 2 select ‘Sort in group’ > ‘Right to left’. 

Next we will co-edge part 3. 

Select part 3 create 10*1 size array. 

Select all part 3 then click  will merge as common line. As shown below. 

Take notice that outline of common line part is thicker. You can see the border of three 

common line design are thicker than lines of shapes inside. 

When the cursor point on the part design it will show the message indicates it's a  

group. 

By same principle part 3 should be cut from top to bottom. 

Drag part 3 close to bottom of part 1 then snap on border. As below: 
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If you want to co-edge all par 1, part 2 and part 3, just select all and click . 

If you don't  need all  parts co-edge then skip this step.  You also need to drag 

part1/2/3 away each other’s border. 

Click space button will turn off snap function temporarily. Snap will function in 

next operation. 

6.2 Regional Output(Dust Collection) 

In CypOne config tool > regional output where you can setup signal ports for dust 

collector. Check  you can setup rows and columns to divide regions 

by your dust collector location. Drag the border line to adjust regions. Or you can 

precisely input border coordinate. When machine located to one region in cutting, 

output of this region will activate then dust collector works to extract polluted fumes. 
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6.3 Motion Parameter Adjustment 

6.3.1 Motion Parameter Specification 

The  motion  parameters  including  speed,  acceleration,  low  pass  filter  and 

corner/curve  precision  are  available  to  adjust  parametrically.  The  parameter 

description listed in below table: 
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Parameter Description

X,Y traverse speed The maximum travel speed.

Traverse acceleration The maximum travel acceleration.

Cut acceleration Maximum cutting acceleration, which also decides acceleration 

in  corner  cutting.  You have to observe the torque curve in 

servo tool to adjust this parameter.

LFP(Low-pass filter) Filter the noise to suppress machine vibration.  Lower value 

means stronger effect but it also lengthen the acceleration 

time.

Curve precision The maximum curve precision of cutting control.  The lower 

the value is, more obvious in speed limit at curve cutting.

Corner precision The precision of corner precision in NURBS curve fitting. The 

lower the value is, corner path will be sharper and speed 

reduction more obvious.

6.3.2 Cutting Acceleration 

Jog motor axis in high speed like 500mm/s. 

Monitor  the  torque curve in  servo tool  when jog the  axis,  increase  the  work 

acceleration if peak torque under 80% or reduce cut acceleration if peak torque larger 

than 80%. 

Adjust the acceleration until peak torque reaches to 80%. The acceleration lead 

screw structure can bear is usually no more than 0.5G. And no more than 2G for rack 

gear structure. 

6.3.3 Traverse Acceleration 

You can put this value calculated by Servo Tools. Or larger than cut acceleration 
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by 1.5~2 times.  The peak torque of servo motor in dry run cannot exceed 150%, 

within  this  range  the  mechanism can  stand  the  impact,  distortion  and  noise.  The 

acceleration lead screw structure can bear usually no more than 0.5G. And no more 

than 2G for rack gear structure. 

6.3.4 Low-Pass Filter 

Adjust low pass filter by cutting a workpiece sample. Lower laser power burns 

marking  on  workpiece.  Observe  and  measure  the  accuracy  of  the  marking  path. 

Marking path can be shapes of circle, star, polygon and square of different size. As 

shown in the following figure: 

Lower the low pass filter as much as possible within desirable cutting precision.  

The indication is no waving at corner cutting. You can directly setup the parameter by  

the below table. Or you can adjust and determine the cut acceleration, then adjust low 

pass frequency around 2 levels around it. Cut acceleration must match with low pass 

filter, one of them cannot be impressively large than the other. 

Level
1 2 3 4 5 6 7 8 9

1

10

Cut 

Acceleration 

0.1 0.2 0.3 0.4 0.5 0.6 0.8 1 1.5 2
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(G)

Low pass filter 

(HZ)
3 3.5 4 5 5.5 6 6 6 7

8

8

6.3.5 Curve & Corner Precision 

Only  under  special  circumstances  to  adjust  the  parameters  in  a  small  extent 

around the default value, otherwise not recommend to modify these two parameters. 

If  the curve precision of cutting not good, you can lower the curve precision 

which will limit the cutting speed at curve path.  If the corner precision of cutting is 

not good, lower the corner precision will limit the cutting speed at sharp corner. The 

value set too large the sharp corner will turn to a round corner. 

6.4 Shortcut Keys 

The table lists the shortcut keys in CypOne for some common operations. 

Shortcut Keys Effect Using conditions

Ctrl + A Select all None

Ctrl + C Copy objects to clipboard Select the objects

Ctrl + Shift + C Copy with basepoint Select the objects

Ctrl + O Open file None

Ctrl + V Paste copied objects to drawing board Copied objects

Ctrl + X Cut objects to clipboard Select the objects

Ctrl + Y Redo the command just revoked There are revoked commands

Ctrl + Z Revoke the command just completed There  are  completed 
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commands

F2 Open  layer  cutting  parameter 

setup window

None

F3 Display all drawing in the center 

screen

None

F4 Display all drawing in the center 

white box

None

F7 Display/hide tool path None

F8 Display/hide position path None

DEL (delete) Delete selected drawing Select the objects

SPACE Repeat previous command The command is repeatable
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